SET TOP BOX
Digital receiver

AX Lion
OWNER'S MANUAL

Read this manual before installation and use.
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SAFETY INFORMATION
TO REDUCE THE RISK OF FIRE AND ELECTRIC SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR
MOISTURE.
: To reduce the
CAUTION
risk of fire and electric shock, do

10. The apparatus shall not be exposed to dripping or splashing and no objects
filled with liquids ,such as vases shall be placed on the apparatus.
Caution: Maintain electrical safety. Powerline operated equipment or accessories
connected to this unit should bear safety certification mark on the accessory itself
and should not be modified so as to compromise the safety features. This will help
The lightning flash with arrow head symbol, within an equilateral
avoid any potential hazard from electrical shock or fire. If in doubt, contact a
triangle, is intended to alert the user to the presence of uninsulated
qualified service personnel.

not remove the cover (or back panel)
of the unit. Refer servicing to qualified service personnel.

"dangerous voltage" within the product's enclosure that may be of
sufficient magnitude to constitute a risk of electric shock.
11. Accessories- Do not place this set-top box on an unstable cart, stand, tripod,

The exclamation point within an equilateral triangle is intended to
alert the user to the presence of important operation and servicing
instructions in the literature accompanying the appliance.
WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO
NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.
CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF
PLUG TO WIDE SLOT AND FULLY INSERT.
The apparatus shall not be exposed to dripping or splashing, and no
objects filled with liquids, such as vases, shall be placed on the apparatus.

IMPORTANT SAFEGUARDS

bracket, or table. The set-top box may fall, causing serious injury to a child or
adult as well as serious damage to the set-top box. Use this set-top box only
with a cart, stand, tripod, bracket, or table recommended by the manufacturer's
or sold with the set-top box. Any mounting of the product should follow the
manufacturer's instructions and use of a mounting accessory recommended by
the manufacturer.
11a. A set-top box and cart combination should be moved with care. Quick stops,
excessive force, and uneven surfaces may cause damage to the set-top box.
12. Outdoor Antenna Grounding- If an outside antenna or cable system is connected
to the set-top box, be sure the antenna or cable system is grounded so as to provide
some protection against voltage surges and built-up static charges. Section 810 of
the National Electrical Code, ANSI/NFPA No.70-1984 (Section 54 of Canadian
Electrical Code, Part1) provides information with respect to proper grounding of
the mast and supporting structure, grounding of the lead-in wire to an antennadischarge unit, connection to grounding electrodes, and requirements for the
grounding electrode.

In addition to the careful attention devoted to quality standards
in the manufacturing of your set-top box, safety is a major factor
in the design of every instrument. However, safety is your
responsibility, too. This sheet lists important information that will
help assure your enjoyment and proper use of the set-top box
13. Power Lines-An outside antenna system should not be located in the vicinity of
and its accessories. Please read them carefully before installing
overhead power lines, other electric light or power circuits, or where it can fall into
and operating your set-top box.
such power lines or circuits. When installing an outside antenna system, extreme

Installation
1. Read and Follow Instructions- All the safety and operation instructions
should be read before the set-top box is operated. Follow all operating
instructions.
2. Retain Instructions- The safety and operating instructions should be
retained for future reference.
3. Heed all Warnings-Comply with all warnings on the set-top box and
operating instructions.
4. Power - This set-top box is supplied with AC power. To prevent electric
shock, ensure the adaptor is inserted correctly into the power
outlet.
5. Power Sources- This set-top box should only be operated with the
ratting specified on the label on the back panel of the set-top box.
If you are not sure of the type of power supply to your home or office,
please consult your set-top box dealer or electrician. For set-top boxes
intended to operate from battery power, or other sources, refer to the
operating instructions.
6. Overloading- Do not overload wall outlets or extension cords as this can
result in a risk of fire or electric shock. Overloaded AC outlets, extension
cords, frayed power cords, damaged or cracked wire insulation, and
broken plugs are dangerous, They may result in a shock or fire hazard.
Periodically examine the cord, and if its appearance indicate damage or
deteriorated insulation, have it replaced by your service technician.

care should be taken to keep from touching or approaching such power lines or
circuits, as contact with them might be fatal. Installing an outdoor antenna can be
hazardous and should be left to a professional antenna installer.
Use
14. Cleaning- Unplug the set-top box from the wall outlet before cleaning.
Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.
15. Objects that may touch dangerous voltage points or "short-out" parts could result in
a fire or electric shock. Never spill liquid of any kind on the set-top box.
16. Lightning-For added protection for this set-top box during a lightning storm, or
when it is left unattended and unused for long periods of time, unplug it from the
wall outlet and disconnect the antenna or cable system. This will prevent damage to
the set-top box due to lightning and power line surges.
Service
17. Servicing-Do not attempt to service this set-top box yourself, as opening or
removing covers may expose you to dangerous voltage or other hazards. Refer all
servicing to qualified service personnel.
18. Conditions Requiring Service-Unplug the set-top box from the wall outlet and
refer servicing to qualified service personnel under the following conditions:
A.
When the AC power adaptor or connecting power cord is damaged.
B.
If liquid has been spilled, or objects have fallen into the set-top box.
C.
If the set-top box has been exposed to rain or water.
D.
If the video does not operate normally by following the operating
instructions.
Adjust only those controls that are covered by operating instructions.
Improper adjustment of other controls may result in damage and will often
require extensive work by a qualified technician to restore the set-top box
to its normal operation.
E.
If the set-top box has been dropped or cabinet has been damaged.
F.
When the set-top box exhibits a distinct change in performance-this
indicates a need for service.

7. Power-Cord Protection- Power-supply cords should be routed so that
they are not likely to be walked on or damaged by items placed upon or
against them, paying particular attention to the point where they exit
19. Replacement Parts-When replacement parts are required, have the service
from the set-top box.
technician verify that the replacements he uses have the same safety characteristics
as the original parts. Use of replacements specified by the set-top box manufacturer
8. Ventilation- Slots and openings in the case are provided for ventilation
can prevent fire, electric shock, or other hazards.
to ensure reliable operation of the set-top box and to protect it from
overheating. These openings must not be blocked or covered. The
20. Safety Check-Upon completion of any service or repairs to this set-top box, ask
openings should never be blocked by placing the set-top box on a
the service technician to perform safety checks recommended by the manufacturer
bed, sofa, rug, or heat register. This set-top box should not be placed in a
to determine that the set-top box is in safe operating condition.
built-in installation such as a book case or rack, unless proper ventilation
is provided or the set-top box manufacturer's instructions have been
21. Wall or Ceiling Mounting- The product should be mounted to a wall or ceiling only
followed.
as recommended by the manufacturer.
9. Attachments- Do not use attachments unless recommended by the
set-top box manufacturer as they may cause hazards.

22. Heat-The product should be situated away from heat sources such as radiators,
heat registers, stoves, or other products (including amplifiers) that produce heat.
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USB port
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for connection to the TV
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RF Loop through
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SYSTEM CONNECTION
General
There are many different types of TV and other equipment that you can connect to the STB.
In this manual you will see some of the most common ways to connect your equipment.

Connecting the TV
HDMI TV

Antenna

HDMI cable

RF cable

Connecting a HiFi system

Hi-Fi

Coaxial cable
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Scart cable

GETTING STARTED
Welcome
If you use the STB for the first time, the "Welcome" menu appears.
Press cursor button to setup the Region, Language, Display Mode
and Aspect Mode.
Highlight "OK" and press the "OK" button to start channel search.

Welcome
Region
Language
Display Mode
Aspect Mode

United Kingdom
English
720p@50HZ
4:3LB

OK

Installation
1
2
3

4

Press the "MENU" button to enter main menu.
Press "UP"or " DOWN " button to highlight "Installation", press
"RIGHT" button to enter the Installation menu.
Press "UP" or "DOWN" cursor button to highlight the desired item
and press "OK"button to enter the sub-menu .
Press "EXIT" button to exit.

Installation
Channel Scan
Auto Scan
LCN

Channel Scan
Channel Scan

1
2

Select " Channel Scan", press the "OK" button to enter the
Channel Scan menu.
Press cursor button to set Scan mode, Scan Band ,Channel No.,
Frequency and Bandwidth, then highlight "Search", press "OK"
button to start channel scan .

Scan Mode
Scan Band
Ch No.
Frequency
Bandwidth
Search

By channel
UHF
CH37(666000KHz)
666000KHz
8MHz

Signal Intensity
Signal Quality

Auto Scan
1
2

81%
97%

Auto Scan

Select the "Auto Scan", press "OK" button to enter the Auto Scan menu.
Press the cursor button to set "FTA Only", then highlight "Search",
press the "OK" button to start auto scan .

FTA Only
Search

LCN
If LCN( Logical Channel Number) Select function is activated, you can't change the original
number of TV channels by scanning .
You can activate/disactivate the LCN function by setting the "LCN " to on/off.
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No

OPERATION
Changing Channels
There are three ways of channel selection - stepping through the channel list, selection by number
and from the on-screen channel list.
1

2

3

Stepping through the channel list:
To move through the channel list, press the upward arrow or downward arrow key on the
remote control.
Selected by number:
Enter the channel number directly by pressing numeric buttons ,and press the "OK" button
to select desired channel.
Selected by on-screen channels list:
You can also select the required channel directly from on-screen channel list. This is
displayed using the STB's main menu. See "Edit Channel" in this manual for operation detail.

Accessing the Electronic Program Guide (EPG)
Accessing the EPG of all channels:
1
2
3
4

EPG

Press "EPG" button to enter EPG menu .
Press cursor button to switch between channel list, events
schedule of the selected channel and now/next events.
Press "Green" button to Timer the events.
Press "Red" button to display " Time Bar" menu.

01:39 xx/xx/xxxx

0010 BBC FOUR
Auntie's War on Smut
01:30-02-30

3/19

0008
0009
0010
0011
0012

01:30

02:00

Time
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02:30

03:00

Interecon
BBC Parl The Recor Commons Questions The Recor
BBC FO Auntie's War on Smut Proms on FOUR
CBeebie This is CBeebies!
301
Timer

EDIT CHANNEL
Edit Channel menu
1
2
3

4

Edit Channel

Press the "MENU" button to enter main menu.
Press "UP" or "DOWN " button to highlight "Edit Channel", press
"RIGHT" button to enter the Edit Channel menu.
Press "UP" or "DOWN" cursor button to highlight the desired item
and press "OK" button to enter the sub-menu .
Press "EXIT" button to exit.

TV Channel List
Radio Channel List
Delete All

TV Channel list
1

In the Edit Channel menu, select "TV Channel List", press "OK"
button to enter TV channel list menu.

2

Press "UP" or "DOWN" button to highlight channel, press the "OK"
button to preview the desired TV channel.

Use this menu to favor, lock, skip, move, sort, delete and rename
channel.
Press "FAV" button, then press "OK" button to edit the FAV
function.
Press "color" button, then press "OK" button to edit the
corresponding function.

TV Channel List
All TV
FAV Lock Skip Move Edit
0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 UKTV Histor
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

YooPlay Ga
xxxxxxxx
xxxxxx
xxxx
xxx

i

Edit Channel
All TV
Sort

Rename Delete

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 UKTV Histor
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

YooPlay Ga
xxxxxxxx
xxxxxx
xxxx
xxx

i

Radio Channel list
1

In the Edit Channel menu, select "Radio Channel List", press "OK" button to enter the Radio
Channel list menu.

2

Press "UP" or "DOWN" button to highlight channel press the "OK" button to listen the desired Radio
channel.

NOTE: Basically, the operation of "Radio Channel List" is the same as "TV Channel List",
but there is one point different: In "Radio Channel List" mode, there is no video
information, so it will always display Radio's logo in the right side preview window.

Delete All
1

In the Edit Channel menu, select "Delete All", press "OK" button.
You are asked to input a password(the default password is"0000").

2

A warning window appears.
Select "Yes", press "OK" button to delete all channels.
Select "No", Press "OK" button to cancel deleting.
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Warning! Do you really want to delete
all channels?

Yes

No

SYSTEM SETUP
System setup menu
System setup menu allows us to set Language, TV System, Local Time
Setting, Timer Setting, Parental Lock, OSD Setting, Favorite, Auto
Description Setting, Multiview Setting and Other.
1
2
3
4

Press the "MENU" button to enter main menu.
Press "UP" or "DOWN" button to highlight "System Setup",
press "RIGHT" button to enter the System Setup menu.
Press "UP" or "DOWN" cursor button to highlight the desired
item and press "OK" button to enter the sub-menu.
Press "EXIT" button to exit.

System Setup
Language
TV System
Local Time Setting
Timer Setting
Parental Lock
OSD Setting
Favorite
Auto Description Setting
Multiview Setting
Other

Language
Language

This menu allows you to set Language.

Language
First Audio
Second Audio
Subtitle Language
Teletext
Subtitle

English
English
German
English
English
On

TV System
This menu allows us to set Video Resolution, Aspect Mode,
Video Out and Digital Audio Out.
Video Resolution:
By Source/By Native/480i/480p/576i/576p/
720p@50HZ/720p@60HZ/1080i@50HZ/
1080i@60HZ/1080p@50HZ/1080p@60HZ
Aspect Mode:
Auto/4:3PS/4:3LB/16:9
Video Out:
SCART CVBS+ HDMI/ SCART RGB
Digital Audio Out:

TV System
Video Resolution
Aspect Mode
Video Out
Digital Audio Out

720p@50HZ
4:3LB
SCART RGB
LPCM Out

LPCM Out/ BS Out

Local Time Setting
This menu allows you to set the region and time.
Region:
This menu is used for changing the region setting.
GMT Usage:
GMT Offset:

This menu is used for open the usage of GMT.
The options are : By Region/User Define/Off
This menu is valid only when selected "User Define"
in GMT Usage menu .
The GMT offset range is "-11:30 ~ +12:00", increasing
half hour progressively.

Local Time Setting
Region
GMT Usage
GMT Offset
Summer Time
Date
Time

France
By Region
GMT+01:00
Off
xxxx/xx/xx
01:51

xxxx,xxx,xxxx

Summer Time: The options are: On/Off
Date:
Time:

"Date" and "Time" menus are valid only when selected "Off" in GMT Usage menu.
Press numeric button to input the time.
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SYSTEM SETUP

Timer Setting
This menu allows us to set the program timer. You can set 8 timers.
Timer Mode:
Off/Once/Daily/Weekly/Monthly
Timer Service:
Channel/Record
Wakeup Channel: You can select a desired channel as the wakeup channel.
Press numeric button to input date.
Wakeup Date:
Press numeric button to input the time.
On Time:
Press numeric button to input the duration time.
Duration:

Current Time/date: 01:36PM xx/xx/xxxx
Timer Mode
Daily
Timer Service
Channel
Wakeup Channel
BBC FOUR
Wakeup Date
xx/xx/xxxx
On Time
xx:xx
Duration
xx:xx
Save

Cancel

Parental Lock
This menu allows you to protect menu and channel, and change the
Password.
1 In "System Setup" menu, select "Parental Lock" and press "OK" button,
you are asked to input a password(the default password is"0000").
2 After inputting the correct password by pressing numeric buttons,
the parental lock menu appears.

Parental Lock
Menu Lock
Rating Lock
New Password
Confirm Password

Off
Off
-------

Menu Lock:

To lock the Edit channel/ Installation menu. When you
want to enter these menus, you must input the password.
You can set menu lock to on/off.
Rating Lock:
Off/ AGE 4/AGE5/AGE6/AGE7/AGE8/AGE9/AGE10/AGE11/AGE12/
AGE13/AGE14/AGE15/AGE16/AGE17/AGE18
New Password: To change the password.
Confirm Password: To confirm the new password.

OSD Setting
This menu allows you to set OSD Timeout and OSD Transparency .
OSD Timeout:

OSD Setting
OSD Timeout
OSD Transparency

1-10

5
Off

OSD Transparency: To set the OSD transparency to Off/10%/20%/30%/
40%.

Favorite
This menu allows you to rename the favorite group.
1 In Channel menu, select "Favorite", press "OK" button to enter
Favorite menu.
2 Select desired group, press "OK" button to open the mock keypad.
Input letter and numeric one by one by pressing the cursor button
and press "OK" button to confirm. After finishing input, highlight
"OK" on mock keypad to confirm, you change Favorite group name
successfully.
3 Press "EXIT" button to quit the group rename menu.
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Favorite
1
2
3
4
5
6
7
8

Fav group 1
Fav group 2
Fav group 3
Fav group 4
Fav group 5
Fav group 6
Fav group 7
Fav group 8

Rename
Fav group 1
A B C D E F
G H I J K L
M N O P Q R
S T U V W X
Y Z 0 1 2 3
4 5 6 7 8 9
SP ? <- OK
CAPS Del OK

SYSTEM SETUP

Auto Description Setting
This menu allows us to set AD Service, Use AD as default and
AD Volume Offset:
AD Service:

On/Off

Use AD as default:

On/Off

AD Volume Offset:

-3~3

Auto Description Setting
On
Off
0

AD Service
Use AD as default
AD Volume Offset

Multiview Setting
Multiview Setting

This menu allows us to set Multiview
1
2

Multiview Setting

4+1Pictures

In "System Setup" menu, select "Multiview Setting" and press "OK"
button, you can select your desired item4+1Picturesor 3x3 Pictures .
After you select your desired item, press "EXIT" button to exit the main
menu, then press "BLUE" button to enter multiview.

Multiview Setting:

4+1 Pictures/3x3 Pictures
4+1 Pictures

3x3 Pictures

Channel
1
Channel1

Channel 2

Channel 1

Channel 2

Channel 3

Channel 4

Channel 5

Channel 6

Channel 7

Channel 8

Channel 9

Channel 5

Channel3

Channel 4

Other
This menu allows us to set LNB Power, Channel Play Type, Beeper and
Auto Standby.
LNB Power:

On/Off

Other
LNB Power
Channel Play Type
Beeper
Auto Standby

When "LNB Power" is selected "On", the STB will provide 5V power
to antenna.
It will not provide when selected "Off".
Channel Play Type:

All/Free/Scrambled

Beeper:

On/Off

Auto Standby:
30Min/1 Hour/2 Hour/3 Hour/Off
No command to STB on front panel or Remoter in 30 Min- 3 hours and no timer event,
the STB will enter standby mode automatically.
If Off is selected, the STB can't enter standby mode automatically.
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Off
All
Off
Off

TOOLS
Tools main menu
1
2
3

4

Press the "MENU" button to enter main menu.
Press "UP" or " DOWN " button to highlight "Tools", press "RIGHT"
button to enter the Tools menu.
Press "UP" or "DOWN" cursor button to highlight the desired item
and press "OK" button to enter the sub-menu.
Press "EXIT" button to exit.

Tools
Information
Factory Setting
S/W Upgrade by OTA
Upgrade By USB
Remove USB device safely

Information
This menu can display some parameters information in this STB.
1

In "Tools" menu, select "Information", press "OK" button to open
information window.

2

Press "EXIT" button to exit.

Information
xxx
xxxxx
xxxxx
xxx
xxx

x.x.x
xxxxx
xxxxx
x.x.x
x.x.x

Factory Setting
This menu allows you to re-set the STB back to factory settings,
clear all existed channels.
1 In the "Tools" menu, select "Factory Default", press "OK" button.
You are asked to input a password(the default password is"0000").
2 A confirmation window is displayed.
Select "Yes" to return back to factory settings and clear all channels.
Select "No" to cancel back to factory settings.
3 Press "EXIT" button to exit .

Factory Setting
This operation will load default and erase all
the channels that user added, continue?

Yes

No

Software Upgrade
We offer the functions for user to upgrade software version by OTA
or by USB .
1

Enter "Tools" menu, select "S/W Upgrade by OTA" or "Upgrade
by USB", press "OK" button, Software Upgrade menu is shown.

2

Press cursor button to select the desired item, then highlight
"Start" and press "OK" button to start upgrade.

3

Press "EXIT" button to exit.

Upgrade by USB
Upgrade Mode
Upgrade File
Start

Allcode
No File
0%

Remove USB device safely
In "Tools" menu, select "Remove USB device safely",
Press "OK" button to confirm. Then a window is displayed.
Press "OK" button again.

Remove

Disk Remove
USB Disk A-3 GB
OK

10
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Cancel

GAME
Game
This menu allows you to play games.
1
2
3

4

Game

Press the "MENU" button to enter main menu.
Press "UP" or "DOWN" button to highlight "Game", press "RIGHT"
button to enter the Game menu.
Press "UP" or "DOWN" cursor button to highlight the desired item
and press "OK" button to enter the game.
Press "EXIT" button to exit.
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Othello
Sudoku

REC
REC main menu
1
2
3

4

REC

Press the "MENU" button to enter main menu.
Press "UP"or "DOWN" button to highlight "REC", press
"RIGHT" button to enter the REC menu.
Press "UP" or "DOWN" cursor button to highlight the desired item
and press "OK"button to enter the sub-menu.
Press "EXIT" button to exit.

Media Player
PVR Storage Information
PVR Setting

Media Player
This function allows you to play files from USB port .
1

2

3
4
5

In "REC" menu, select "Media Player", press "OK" button to enter
Media Player menu.
First you enter media player window, the highlight is on the
USB/HDD device. Press "Down" button to move the highlight to
directory and file field.
Press "1" button ,you can switch TAB between
Music/Image/Video/Record.
Press "UP" or "DOWN" cursor button to select a desired item,
and press "OK" button to play the desired files.
Press "EXIT" button to exit.

Music

Image

Video

Record

USB 1
/..

1
2
3
4
5
6
7

MPG
MP3
MP3
MP3
MP3
JPG
JPG

840.mpg
I swear.mp3
Why.mp3
Lonely.mp3
Because.mp3
Rose.jpg
Fly.jpg

00:03:15 00:03:32

INFO

Play List
1 Switch

I swear.mp3
3319KB
00:03:32

FAV
2 Sort

i

FAV All
Repeat

Edit
EXIT Exit

Music:
"RED" button:
"GREEN" button:

Press "RED" button to show Play List.
Move the highlight to the file which you want to add to play list, then press
"Green" button to add. It will mark a favorite icon on the file.
"YELLOW" button: Press "Yellow" button to add all file of current directory to play list. Press again to
delete all file of current directory from the play list.
"BLUE" button:
Press "Blue" button to enter to edit sub-menu.
"2" button:
Press "2" button to open the sort window.
You can sort by Name/Time/Size/Favorite.
"INFO" button:
Press "INFO" button to set repeat mode. The option is Repeat Folder/
Random Folder/Repeat One.
"EXIT" button:
Return to parent directory.
Image:
"RED" button:
"GREEN" button:

Press "Red" button to show play list.
Move the highlight to the file which you want to add to play list, then press
"Green" button to add. It will mark a favorite icon on the file.
"YELLOW" button: Press "Yellow" button to add all file of current directory to play list. Press again to
delete all file of current directory from the play list.
"BLUE" button:
Press "Blue" button to enter to edit sub-menu.
"2" button:
Press "2" button to open the sort window.
You can sort by Name/Time/Size/Favorite.
"INFO" button:
Press "INFO" button to open image setup.
NOTE: When you browse pictures ,
"3" button:
Press "3" button to view image in
multi view mode.
press "RED" button or "GREEN" button,
you can view 3D pictures.
"EXIT" button:
Return to parent directory.
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REC

Video:
"BLUE" button:
"2" button:
"EXIT" button:

Press "Blue" button to enter to edit sub-menu.
Press "2" button to open the sort. You can sort by Name/Time/Size.
Return to parent directory.

Record:
"RED" button:
"GREEN" button:

Press "Red" button to open rename window.
Move the highlight to the program which you want to lock. Pressing "Green"
button, it will ask you to input password. Default password is "0000". After
input correct password, the program is locked. If you want to unlock the
program, press the "Green" button again.
"YELLOW" button: Press "Yellow" button to make a delete mark on the program which
you want to delete.
"EXIT" button:
Return to parent directory.

PVR Storage Information
This menu can display some parameters of Removable Disk.
1

In "REC" menu, select "HDD Information", press "OK"
button to open HDD information window.

2

Press "EXIT" button to exit.
Format

PVR Storage Information
USB Disk A: xxxG bytes

Volume
Total Size
Free Size
Rec Size
TMS Size
File System

FAT/NTFS

Press YELLOW button to open Format menu.
Press "LEFT" or "RIGHT" cursor button to change Disk Mode.
Select "OK" to format. Select "Cancel" to cancel.

xxxx
xxxx
xxxx
xxxx
xxxx
xxx

Format

DVR Set

Format
Disk Mode

DVR Set

REC&TMS/Record/Timeshift

FAT

OK

Press BLUE button to open DVR Set menu.
Press "LEFT" or "RIGHT" cursor button to change DVR Type.
Select "OK" to confirm. Select "Cancel" to cancel.

DVR Type

Cancel

DVR Set
REC& TMS

OK

Cancel

PVR Setting
This menu allows us to set the PVR Setting.
Press "UP" or "DOWN" cursor button to select desired item,
press "LEFT" or "RIGHT" cursor button to change the setting.
TimeShift
AUTO/Pause/Off
Timeshift to Record

On/Off

PS Record

On/Off
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PVR Setting
Timeshift
Timeshift to Record
PS Record

Pause
Off
Off

TIMESHIFT/RECORD
Plugging an external Mass Storage Device on the USB port gives you access to Time Shift/Record
a broadcast programme.
Pause a broadcast programme and continue watching it later (Time Shift )
Record a broadcast programme.
When the space available on the Mass Storage Device runs out, recording operation of
broadcast will stop.
NOTE:

Please use USB 2.0 disk when recording or timeshift.
For timeshift and recording feature, you need take bigger size USB pen
driver or HDD (>2GB) for recording.

Timeshift
Initiate
Time Shift can be done in viewing mode by pressing the
"PAUSE" button.
Press "RIGHT" or "LEFT" button to move the cursor to
the time you desired to view. Press "OK" button to confirm.

BBC FOUR
Play

00:02:37

03/19
00:07:12

01:36
2%
TS

Trickmodes
During the playback, it is possible to perform the following actions :
Press "PAUSE" button to pause the playback
Press "FORWARD" button to fast forward the playback
Press "BACKWARD" button to rewind the playback
Stop the Time Shift
Press "STOP" button to stop TimeShift.

Record
Instant record
In viewing mode, press "RECORD" button to instantaneously start a record on the current channel.
Press "RECORD" button again can input duration.
Press "STOP" button to stop recording, then a confirmation window appears.
Select "Yes" to stop recording. Select "No" to continue recording.

NOTE:
Please select famous brand USB 2.0 USB HDD or USB stick for Recording and Timeshift, such as SAMSUNG,
HITACHI and SONY. Some USB devices maybe can't be supported due to its quality.
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TROUBLESHOOTING
In some region, the digital terrestrial signal may be weak. So you'd better use the antenna in
which the booster was built, for watching the weak signal channels.

Problem

Possible cause

What to do

Standby light not lit

Mains lead unplugged
Mains fuse blown

Check mains lead
Check fuse

No signal found

Aerial is disconnected
Aerial is damaged/misaligned
Out of digital signal area

Check aerial lead
Check aerial
Check with dealer

No picture or sound

Scart/AV is not selected on your TV

Reduce to another channel

Scrambled channel
message

Channel is scrambled

Select alternative channel

No response to remote
control

Receiver off
Handset not aimed correctly
Front panel obstructed
Hand set batteries exhausted

Plug in and turn on plug
Aim handset at front panel
Check for obstructions
Replace handset batteries

Forgotten channel lock
code

Re-install channels to cancel
channel lock

Forgotten menu lock
code

Contact help line

The remote control will
not operate your STB

(1) The batteries in your remote
control need replacing
(2) There is an obstruction
blocking the signal path
between the remote control
and the box.

(1) Replace the batteries
(2) Check that there is nothing in
the way of the path between
the remote control and the
receiver

After moving the STB to
another room you find you
are no longer able to
receive digital reception

The aerial feed former new point
may come through a distribution
system which may reduce the
digital signal now received by the
box.

Try a direct feed from the antenna
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SPECIFIC ATIONS
TUNER & CHANNEL

RF INPUT CONNECTOR x1
(IEC-TYPE, IEC169-2, FEMALE)
RF OUTPUT CONNECTOR x1
(IEC-TYPE, IEC169-2, MALE (LOOPTHROUGH))
FREQUENCY RANGE:
174MHz~230MHz(VHF)
470MHz ~862MHz (UHF)
SIGNAL LEVEL:
-15 ~ -70 dbm

DECODER
Video decoder

MPEG-2 MP@HL, AVC/H.264 HP @L4.1
MPEG-4 ASP SUPPORTED
MPEG-1 Layer 1,2/PCM/HE-AAC V1.0
ICE958 SPDIF
MAX. 48Mbit/s
4:3/,16:9 SWITCHABLE
HDMI, SCART
QPSK,16QAM,64QAM

Audio decoder
INPUT RATE
VIDEO FORMATS
VIDEO OUTPUT
MODULATION
CONNECTION
MAIN POWER CABLE

FIXED TYPE

TUNER

ANTENNA INPUTx1, RF OUTPUT x1

SCART

TO TV x1

DATA PORT

USB slot

SPDIF

COAXIAL x1

HDMI

HDMI OUTPUT x1

POWER SUPPLY
INPUT VOLTAGE
POWER CONSUMPTION
NOTE:

220-240V~, 50/60Hz
MAX. 6W

Design and Specifications are subject to change without notice.
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